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EVAL-M1-101T User Manual

iMOTION™ Modular Application Design Kit

About this document

Scope and purpose

This application note provides an overview of the evaluation board EVAL-M1-101T including its main features,
key data, pin assignments and mechanical dimensions.

EVAL-M1-101T is an evaluation-board as part of the IMOTION™ Modular Application Design Kit. This board
features and demonstrates Infineon’s Advanced Motion Control Engine (MCE 2.0) technology for permanent
magnet motors drive over the full speed range.

The evaluation board EVAL-M1-101T was developed to support customers during their first steps designing
applications with running any permanent magnet motor via sensorless sinusoidal control.

Intended audience

This application note is intended for all technical specialists who know motor control and high power
electronics converter and this board is intended to be used under laboratory conditions.
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1 Safety precautions

In addition to the precautions listed throughout this manual, please read and understand the following
statements regarding hazards associated with development systems.

Table1 Precautions

Attention: The ground potential of the EVAL-M1-101T system is biased to a negative DC
bus voltage potential. When measuring voltage waveform by oscilloscope, the scope’s

ground needs to be isolated. Failure to do so may result in personal injury or death and
equipment damage

Attention: Only personnel familiar with the drive and associated machinery should plan
or implement the installation, start-up and subsequent maintenance of the system.
Failure to comply may result in personal injury and/or equipment damage.

Attention: The surfaces of the drive may become hot, which may cause injury.

Attention: EVAL-M1-101T system contains parts and assemblies sensitive to Electrostatic
Discharge (ESD). Electrostatic control precautions are required when installing, testing,
servicing or repairing this assembly. Component damage may result if ESD control
procedures are not followed. If you are not familiar with electrostatic control procedures,
refer to applicable ESD protection handbooks and guidelines.

Attention: A control board, incorrectly applied or installed, can result in component
damage or reduction in product lifetime. Wiring or application errors such as under sizing
the motor, supplying an incorrect or inadequate DC supply or excessive ambient
temperatures may result in system malfunction.

Attention: Remove or connect this control board from or to the power drive. Wait three
minutes after removing power from the power drive to discharge the bus capacitors. Do
not attempt to service the drive until the bus capacitors have discharged to zero. Failure
to do so may result in personal injury or death.

Attention: EVAL-M1-101T system is shipped with packing materials that need to be
removed prior to installation. Failure to remove all packing materials which are
unnecessary for system installation may result in overheating or abnormal operating
condition.

o ot
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2 Introduction

The EVAL-M1-101T evaluation board is a part of the iIMOTION™ Modular Application Design Kit for drives
(IMOTION™ MADK). In order to run a motor, the mating power board is required to interface this evaluation
board.

The MADK platform is intended to use various power stages with different control boards. These boards can
easily be interfaced through the 20-pin iMOTION™ MADK M1, or the 30-pin iIMOTION™ MADK M3 interface
connector. This board is equipped with 20-pin M1 connector and is intended for single motor control only.

This evaluation board is designed to give comprehensible solutions of sensorless control of permanent magnet
motors over the full speed range. It provides a capable of 3-phase and type 3 of 2-phase modulation, a micro-
USB connector and on board debugger isolated by digital isolator, and UART interface.

The EVAL-M1-101T evaluation board is available from Infineon. The features of this board are described in the
main features chapter of this document, whereas the remaining paragraphs provide information to enable the
customers to copy, modify and qualify the design for production according to their own specific requirements.

Environmental conditions were considered in the design of the EVAL-M1-101T, but it is not qualified regarding
safety requirements or manufacturing and operation over the whole operating temperature range or lifetime.
The boards provided by Infineon are subject to functional testing only.

Evaluation boards are not subject to the same procedures as regular products regarding Returned Material
Analysis (RMA), Process Change Notification (PCN) and Product Discontinuation (PD). Evaluation boards are
intended to be used under laboratory conditions by technical specialists only.

Figure 1shows the evaluation board EVAL-M1-101T. This document explains the features and details of this board
as well as control IC which is IMC101T-T038.

it
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Figurel Evaluation board EVAL-M1-101T
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3 EVAL-M1-101T main features

EVAL-M1-101T is an evaluation control board for motor control applications. The kit demonstrates Infineon’s
motion control IC technology.

Main features of the IMC101T-T038 Motion Control IC are:

e MCE (Motion Control Engine) as ready-to-use solution for variable speed drives

o Field oriented control (FOC) for permanent magnet synchronous motor (PMSM)

e Space vector PWM with sinusoidal commutation and integrated protection features
e Current sensing via single or leg shunt

e Sensorless operation

e Various serial communication interfaces (UART, 12C, SPI)

e Multiple motor parameter support

e 3.3V (default) or 5V VDD power supply

o Flexible host interface options for speed commands: UART, 12C, SPI, PWM or analog signal
e Support for IEC 60335 (‘Class B’)

e Scalable package options

The evaluation board characteristics are:

e Complete kit for running any permanent magnet motor via sensorless sinusoidal control
o 3.3V (default) or 5V VDD power supply

e Micro-USB connector and on-board debugger isolated by digital isolator

e Capable of 3-phase and type 3 of 2-phase modulation

e RoHS complaint

e PCBsizeis65x45mm

User Manual 50f33 Revision 1.6
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3.1

Figure 2 shows a typical motor control application block diagram using the IMC101T-T038. The IMC101T-T038
provides a built-in closed loop sensorless control algorithm using the unique flexible Motion Control Engine (MCE)
for permanent magnet motors. The MCE™ consists of a collection of control elements, motion peripherals, a
dedicated motion control sequencer and internal memory to map internal signal nodes. IMC101T-T038 also
employs a unique single shunt current reconstruction circuit in addition to leg shunt current sensing circuit to
eliminate additional analog/digital circuitry.

Functional description

IPM based or discrete MADK power board

EHN

I
EMI Filter |
I
I

& Rectifier

Host
Communication

[ Analog

3-phase
inverter

EVAL-M1-101T Current Sensing

single/ legshunt

Isolated
On-Board
Debugger

Figure2  Typical Application Block Diagram Using IMC101T-T038

3.2 IMC101T-T038 pinout description

The main part of the EVAL-M1-101T MADK control board is the IMC101T-T038 iMOTION™ motor control IC.
Figure 3 depicts the pinout of the IMC101T-T038 IC. IMC101T-T038 comes in a compact 9.7mm x 6.4mm 38-pin
TSSOP package.

C]:0 8 -
voc[_| 2 37 [ Jw
v 3 36 [ | REFW
REFV[ | 4 35 [ Jvsp
REFU[_| 5 34 [ ] TxDO
wl_ | s 33 [ | RXDO
NTC[ | 7 2 -
PARAM[__| 8 31 [ | DUTYFREQ
ws—] . IMCLOIT
voD[ | 10 TO38 2 [ -
pwmuL[ | 11 (Top View) 28 [ ]DR
PWMUH[ | 12 27 [ |PAR3
PWMVL[ | 13 26 [ |vbD
PWMVH[ | 14 25 [ Jvss
PwMwL[ | 15 24 [ |PAR2
PWMWH[ | 16 23 [ |PARL
LED[_ | 17 22 [ |PARO
Gk[_| 18 21 [ ] PGout
1| 19 20 [ ] RxD1
Figure3  Pinout of IMC101T-T038
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Table 2 lists the available pins of IMC101T-T038 with short descriptions. For more detailed information, please
refer to the datasheet or User Manual for iMOTION™ IMC101T-T038 motor control IC.

Table 2 IMC101T-T038 pinout description
Pin# Type Pin Name Description
1 - - not used
2 AIN VDC DC bus sensing input
3 AIN IV/AING Phase V current leg sensing
4 AIN REFV/AIN7 Itrip phase V reference
5 AIN REFU/AIN8 Itrip phase U reference
6 AIN U Phase U leg sensing or single shunt
current sensing
AIN NTC external temp sense input
AIN PARAM Parameter table selection, analog
Power VSS ground
10 Power VDD VDD supply power
11 0 PWMUL motor PWM phase U low side
12 o PWMUH motor PWM phase U high side
13 0 PWMVL motor PWM phase V low side
14 o PWMVH motor PWM phase V high side
15 0 PWMWL motor PWM phase W low side
16 0 PWMWH motor PWM phase W high side
17 0] LED Status LED
18 I GK Motor Gatekill input
19 0 TXD1 UART1 Transmit for host interface
20 I RXD1 UART1 Receive for host interface
21 0] PGOUT PG output
22 I PARO Parameter page select bit 0
23 I PAR1 Parameter page select bit 1
24 I PAR2 Parameter page select bit 2
25 Power VSS ground
26 Power VDD VDD supply power
27 I PAR3 Parameter page select bit 3
28 I DIR direction input
29 - - not used
30 - - not used
31 I DUTYFREQ Duty/Freq input for speed input
32 - - not used
33 I RXDO UARTO Receive for SW download
34 o TXDO UARTO Transmit for SW download
35 AIN VSP Analog speed reference input
User Manual 70f33 Revision 1.6
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36 AIN REFW Itrip phase W reference
37 AIN IW Phase W current leg sensing
38 - - not used

3.3 EVAL-M1-101T board specifications

Table 3 depicts the important specifications of the evaluation board EVAL-M1-101T.

Table 3 EVAL-M1-101T board specifications
Parameters Values Conditions [ comments
Host Interface (Not isolated)
UART(TXD RXD) 0-VDD Serial port 1 typical 57600 Bps
AIN 0-VvDD analog input
DIN 0-VvDD digital input
DOUT 0-VDD digital output
FG 0-30V digital output with open drain
structure
Input
VDD ‘ 3.3V (default), 5V Controller supply voltage
DC Bus
DC Bus Scaling 8.20 counts/V 13.3kQ resistor on control board,
DC Bus sensing range 499.54V max and 2MQ resistor on power board
Current feedback
Internal Current Feedback 1,3,6,12 Configured by MCEWizard
Amplifier Gain
Current sensing device 0 - VDD/Gain Single shunt resistor
Leg shunt resistor
Current Op-amp Configuration Non-Inverting default setting
Current External Amplification 0.833
Gain
Resolution 12-bit PCB design may reduce the
resolution
Latency 1 pwm cycle

Protections

NTC Temperature shutdown value | 0-VDD (configured by
MCEWizard)

PCB characteristics
Material FR4, 1.6MM thickness
Copper thickness = 10z (35um)

Dimension 65mmx45mm
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Parameters Values Conditions [ comments

System environment
Ambient temperature -40-105°C

3.4 Pin assignment
Essential information about the connections of the EVAL-M1-101T evaluation board is described below.

Table 4 includes the details of UART connectors.

Table 4 J1- UART Connector

Pin Nr. Pin Details

1 TXDO Serial port 0 Output, IMC101T-T038 transmit data to master controller
2 RXDO Serial port 0 Input, IMC101T-T038 receive data from master controller
3 +3.3V VDD power supply

4 GND Ground

5 GND Ground

6 +3.3V VDD power supply

7 RXD1 Serial port 1 Input, IMC101T-T038 receive data from master controller
8 TXD1 Serial port 1 Output, IMC101T-T038 transmit data to master controller

Table 5 provides the pin assignments of the iIMOTION™ MADK-M1 20 pins interface connector J2. This connector
is the interface to the power board.

Table 5 J2- iMOTION™MADK-M1 20 pins interface connector for control board

Pin Name Pin Name Connectors

1 PWMUH VDD compatible logic output for high side gate driver-Phase U

2 GND Ground

3 PWMUL VDD compatible logic output for low side gate driver-Phase U

4 GND Ground

5 PWMVH VDD compatible logic output for high side gate driver-Phase V

6 +3.3V On board VDD supply

7 PWMVL VDD compatible logic output for low side gate driver-Phase V

8 +3.3V On board VDD supply

9 PWMWH VDD compatible logic output for high side gate driver-Phase W

10 U+ Shunt voltage phase U

11 PWMWL VDD compatible logic output for low side gate driver-Phase W

12 U- Ground

13 GK Gate kill signal - active low when over current is detected

14 DCBSENSE DC bus positive voltage, scaled in 0 - VDD range by a voltage divider
User Manual 90f33 Revision 1.6
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Pin Name Pin Name Connectors

15 VTH Thermistor input

16 IV+ Shunt voltage phase V

17 IV- Ground

18 IW+ Shunt voltage phase W

19 IW- Ground

20 VCC Defined for 15V Power Supply (not used in this board)

Table 6, Table 7 and Table 8 include the details of test signal pin connectors.

Table 6 Digital signal test pin connecter JP1
Pin Name Pin Name Connectors
1 PGOUT PG (Pulse Generation) output
2 PARO Parameter page select bit 0
3 PAR1 Parameter page select bit 1
4 PAR2 Parameter page select bit 2
5 GND Ground
6 +3.3V VDD power supply
7 PAR3 Parameter page select bit 3
8 DIR Direction input
9 - not used
10 - not used
11 DUTYFREQ Duty/Frequency input for speed input
12 - not used
Table 7 VSP signal test pin connector JP2
Pin Name Pin Name Connector
1 +3.3V VDD power supply/ +3.3V by default
2 VSP Analog speed reference input
3 FG open drain output for speed as shown in Figure 23
4 GND Ground
Table 8 Analog signal test pin connector JP3
Pin Name Pin Name Connector
1 +3.3V VDD power supply
2 - not used
3 - not used
4 PARAM Parameter table selection
5 GND Ground
User Manual 10 of 33 Revision 1.6
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4 Getting Started with EVAL-M1-101T

In order to run the motor system, a combination of the IMOTION™ MADK control board (EVAL-M1-101T) and the
matching MADK power board (with M1 connector) is required. The iIMOTION™ Software Tools MCEDesigner and
MCEWizard are also required in order to initialy setup the system, as well as to control and fine-tune the system
performance to match users exact needs. This chapter provides more details on setting up the system and
getting started with iMOTION™ MADK development platform.

4.1 Setting up the system

EVAL-M1-101T consists of several functional groups which enable out-of-the-box, fully functional motor control
system combined with additional interfaces and test points for more advanced use cases. Figure 4 shows the
functional groups of the EVAL-M1-101T evaluation board.

1. On-board debugger

2. USB Connecter (X101)

3. Digital Signal Test Pin
Connecter (JP1)

4, iMOTION™ MADK M1
20-pin interface
connector (J2)

5. iMOTION™ IMC101T-
T038 motor control IC

6. iIMOTION™ Link and

UART connector (J1)
- 188 pFE & 121l e 7. VSP Signal test Pin
5 e RN Connecter (JP2)
nf'neon f 8. Analog Signal Test Pins
EUAL-1-101 T OO0 YA Connecter (JP3)

2017-12-0%

Figure4  Functional groups of the EVAL-M1-101T evaluation board’s top side

After downloading and installing the IMOTION™ PC Tools (MCEWizard and MCEDesigner), following steps need
to be executed in order to run the motor. Refer to chapters 0 and 4.2.2 as well as MCEWizard and MCEDesigner
documentation for more information.

1. Getthe latest "IMC101T-T038 MCE Software Package” available on www.infineon.com/imotion-software
web page.

2. Connect PC-USB connector on the on-board-debugger to the PC via USB cable.

3. Connect EVAL-M1-101T’s M1 20-pin interface connector (J2) to power board (For example EVAL-M1-05-65D,
see Figure 5).

4. Use MCEWizard to enter the target motor’s system and operating parameters, as well as evaluation board’s
hardware parameters, which will then be used to calculate controller’s digital parameter set representing
complete motor drive system. First click “Calculate” button on the “Verify & Save Page” and then save the
drive parameter set into your project directory by clicking “Export to Designer file (.txt)”. Saved Drive
System Parameter File will be later used by the MCEDesigner. Refer to Chapter 4.2.1 or MCEWizard User
Guide for more details.

5. Connect motor phase outputs to the motor.

6. Connect AC power to power input connector and power on system.

User Manual 110f33 Revision 1.6
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7. Start MCEDesigner tool and open MCEDesigner default configuration file (.irc) for IMC101T-T038 controller
(IMC101T_Vxxx.irc) by clicking “File” > “Open”. IMC101T_Vxxx.irc file is included in the ”IMC101T-T038 MCE
Software Package” downloaded in step 1.

8. MCEDesigner should automatically connect to the EVAL-M1-101T control board using default COM port
(Indicated by green circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI). If it
cannot establish the connection, change COM port by doing following steps: (“System” window active) >
Preferences > Connection > Connect using (Chose one of the other available COM ports from the drop-down
menu).

9. Incasethe IMC101T-T038 IC on the EVAL-M1-101T is empty (not programmed), which will be indicated by
the pop-up window message after connecting to the MCEDesigner, then use following steps to program the
firmware and the system parameters into the internal SRAM of iMOTION™ IC: Click “Tools” > “Programmer”
and select “Program Firmware and Parameters”. Browse and select the IMC101T-T038_A_Vxxx.ldf file which
was included in the IMC101T-T038 MCE Software Package” downloaded in step 1. Then browse and select
the System Drive Parameters .txt file created in step 4. See chapter MCEDesigner setup overview 4.2.2 for
more details.

10. In case the IMC101T-T038 IC firmware has alredy been loaded, use following steps to program the system
parameters into the internal SRAM of iMOTION™ IC: Click “Tools” > “Programmer” and select “Program
Parameters”. Browse and select the System Drive Parameters .txt file created in step 4.

11. Start the motor by clicking the green traffic light button in the control bar.

AC Power
Input

..........

PC-USB
Connector

Motor Phase
Outputs

Figure5 System connection example using EVAL-M1-101T and EVAL-M1-05-65D
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4,2 iMOTION™ development tools and software

The iIMOTION™ Development Tool installers for MCEDesigner and MCEWizard are available for download via
Infineon iIMOTION™ website (http://www.infineon.com/imotion-software). All supported tools and software
variants are listed there. Please visit this page periodically to check for tool/software updates.

Isolated on-board debugger provides the USB to UART brigde between the PC and the target iMOTION™ device
with 1kV DC galvanic isolation between the motor drive system (hot side) and the PC/debugger (cold) side. On-
board debugger uses the SEGGER J-Link driver for UART communication with IMC101T-T038. J-Link driver will
be installed during the MCEDesigner installation. In case the driver is not installed properly, please go to
SEGGER J-Link website to download and install the latest J-Link “Software and Documentation pack for
Windows”.

4.2.1 MCEWizard setup overview

After installing the MCEWizard, the shortcut for MCEWizard appears on the Windows desktop. Double click the
shortcut to open the MCEWizard and configure the parameters for evaluation boards or motor. Figure 6 shows
the “Welcome Page” for MCEWizard, where the MADK control board or power board can be selected through
the pull-down list. Infineon keeps releasing new MADK controller and power boards. Therefore, it could happen
that some of the newest power boards are not pre-configured in the MCEWizard tool and cannot be selected
through the pull-down menu. In that case, the user should select any other power board (as similar as possible)
and follow the MCEWizard setup steps by entering the parameter values which are specific to the chosen board.
Make sure both “I have modified the circuit board” and “Enable advanced question” checkmarks are selected.
Please refer to the Application Note of the corresponding power board for additional information.

After selecting the MADK control and the power board, start the MCEWizard system setup procedure by clicking
the “Next” button in the right bottom corner as shown in Figure 6.

= -
§) Irhreen Techndogies - MCEWad 20020 ol ——

Fle lumpTc Hdp

Welcome Page

. T :

IMotion System Parameter Configuration Wizard

What Centrol Soard 806 you ssing? - Eenl-Mi-1037
vhat Fowar Bodrd 2re you w56g? | Bvdi-MI-0G-650
wtom Desgm Quastions
7 L have modfied the orest bod

¢ Enadle advancod quastions.

Figure6  Welcome Page of MCEWizard
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iMOTION™ MADK system enables users to easily test different combination of control and power board with
their motors. User should be familiar with the system level parameters which are related to the motor used.
There is a very limited number of parameters which are specific to the control board or power board hardware.
Table 9 provides the MCEWizard setup overview for hardware related parameters. Similar tables will be
available in each power board’s Application Note. Combination of this table and the corresponding table of the
power board provides enough information to setup the MADK-based motor drive system in shortest time.

Table9 MCEWizard setup overview table
Page Parameter Value Comment
Welcome Page | Power Board selecting MADK power board name If no, select similar

power board to modify

Options Page | Motor 1 Shunt Configuration | Refer to the power board App Note

Question 3 Controller Supply Voltage Refer to the power board App Note | VDD is 3.3V by default

Question 19 Max DC Bus Voltage Refer to the power board App Note

Question 23 DC Bus Sensing High Resistor | Refer to the power board App Note
Question 24 DC Bus Sensing Low Resistor | 13.3 kOhm

Question 54 | NTC Temperature Shutdown | Calculated as the Section 5.2.2 Refer to the power
value board App Note

Question 63 | GateSense Low-Side Devices | Refer to the power board App Note | High is true by default

Question 64 | GateSense High-Side Devices | Refer to the power board App Note | High is true by default

Question 69 Motor 1 Current Input Calculated as the Section 5.1.2

After all the MCEWizard questions are answered, the “Verify & Save Page” will be shown as in Figure 7.

rd‘: Irdnesn Techndlogies - MCEWland 20020 o ——
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Verify Parameters
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Doabie-Click an tom 10 JUNF 1o its aszooated question
Irformatcn #1 : Frmware Verzon
Finsware Vergon w INOTRIQ V10
Irformation 22 & System OacX
Cobaurietions ece azed on an MCE cinck ruto of 56 M
Infarmation #3 : Systen DC Bus Feedback Scalng
The DC lus Foatback Scaing is §.20 cosMu VT and mae metsurabie viltaze @ 495 54V
Irfocmation 24 : Mator £ Current Feadzack Scaling
The Motor Current Feadieck Scsing 15 77563 courty/Apt ond mange = 2.04 Apk

Fravieus Tl

Figure7 Verify and Save page for MCEWizard

Click “Calculate” button and “Export to Designer File (.txt)” button to save the parameter file which will be used
by the MCEDesigner in the next steps.
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4.2.2 MCEDesigner setup overview

After installing MCEDesigner installer, there is a shortcut for MCEDesigner on Windows desktop. Double click
the shortcut to open MCEDesigner and then open “IMC101T_xx.irc” file as shown in Figure 8.

TAF owwn W HTT NG BN | omon Sachoongel - A [msgeer w 2 09 -
= . —

- Ve P o
“ 5 08 L

* Sywen WA A

" oy Cma et P o g
o B Mt (i v

N

| ae— gt
5=

Figure 8 MCEDesigner’s Main Display for EVAL-M1-101T

MCEDesigner programmer function can be used to program IMC101T-T038 firmware and/or System
parameters. To call this function, click on “Tools” menu and then select “Programmer” in the pull down list.
The pop-up window “Program IMC controller” will show up as in Figure 9.

To program both firmware and Drive System Parameters into IMC101T-T038 (which can happen when
programming for the first time the brand new devices with default factory setting, or when the new version of
iMOTION™ firmware is being downloaded), first click on the “Program Firmware and Parameter” radio button in
the “Program IMC controller” pop-up window. After that, select the Drive System Parameter file created using
MCEWizard by clicking on the “Browse...” button at the end of the “Program Parameter File” row, and then also
select the the IMC101T-T038_A_Vxxx.ldf file (which was included in the “IMC101T-T038 MCE Software Package”)
by clicking on the “Browse...” button at the end of “Program Firmware File” row. Finally, click on the “Start”
button to program the parameter file into the IMC101T-T038 IC.
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Figure 9 Program Firmware and Parameter in “Program IMC Controller” pop-up window

To program only Drive System Parameter file into IMC101T-T038, click on “Tools” menu and select
“Programmer” in the pull down list. The pop-up window “Program IMC controller” will show up as in Figure 10.
Click on the “Program Parameters” radio button (this is the default option), and then select the Drive System

Parameter file created using MCEWizard by clicking on “Browse...”. Finally, click on the “Start” button to
program the parameter file into the IMC101T-T038 IC.

Figure10 “Program IMC Controller” pop-up window

After Drive System Parameter file has been programmed into IMC101 controller, and the motor drive system is
powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change the motor

speed, modify drive parameters and many other functions. Please refer to the MCEDesigner documentation for
more details.
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Note: On-board Debugger portion of EVAL-MI1-101T is galvanically isolated from the controller portion
and the attached power board. In order to program the parameters or firmware to the IMC101T-
T038 controller, the 3.3V DC voltage needs to be supplied to the controller portion of the EVAL-M1-
101T. This voltage can either be supplied by the power board (MADK power boards are designed to
supply the 3.3V to the control board through M1 or M3 connector) or by feeding the 3.3V DC voltage
to the control board through some of the available 3.3V access/test points if the power board is not
attached to the EVAL-M1-101T control board.

All latest firmware file for different type of iIMOTION™ control ICs are available for download via Infineon
iMOTION™ website (http://www.infineon.com/imotion-software).
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5 Hardware description of EVAL-M1-101T

This chapter covers hardware design of the EVAL-M1-101T in more details. To enable users to make the EVAL-
M1-101T evaluation board a basis for a new development or modification of their own systems, all necessary
technical data like schematics, layout and components are also included in this chapter.

5.1 Current feedback circuitry

5.1.1 Shunt configuration

Both single shunt and leg shunt topologies are supported by the EVAL-M1-101T control board. The user needs
to make sure that the shunt configuration matches with power board hardware configuration. Please refer to
the power board Application Note for details. The shunt configuration can be changed in MCEWizard by clicking
and selecting in the pull down list marked with red box as shown in Figure 11.

fle mumpTc Hep
Opbors Foge
Base Configuration Options
Carrere Configuration Cyvtem Freqaenoes
7 Ltk b modify FAM Gaquescy
Froduct Family MOTIONG NCE
Mptor § AWN Frequency 16 o
Frodoct Name MoTION
B Control Ral ‘
Motort Shint Configeration Leg Shent Pt Cantrol Rate i I
Contrel Ingit ART »
| MCECoa Frog: sy Coniretirgt
Motor & PWN Fraq: 15.00
vaming: Too hgh FWM Frequency or wiang contros ingut
- may lead to no response ot ol o external commands
d Cuszom Crout Board £nnchd
R s
1 Caustom MCE Azplction: Desablad
'
I Adduosal Qprons
3 Firmware Version CRU Usage/Loadng
wamng: Make sure shurt configuration matchas with vaming. Total MCE Usaga should be limited to $0% to allow
hardware CPU avadebiny for other Sasks
Fravious hua

Figure 11 Shunt Configuration

5.1.2 External Current feedback configuration and calculation

The shunt resistance Ry, value can be found in the schematics or application note for the power board (For
example, the leg shunt resistors are 100mQ for EVAL-M1-CM610N3 and 250mQ for EVAL-M1-05-65D).

The current input value is product of the shunt resistance in milliohms and gain of External current sense
amplifier as shown in Figure 12.

Current Input
(mV/A)

Figure 12 Current shunt feedback and sample timing
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Figure 13 depicts IU+ current feedback sensing circuity on EVAL-M1-101T evaluation board. Please note that the
default external amplification gain is less than 1 for current sense in this evaluation board.

iMOTION
Controller
U
Current shunt
resistor on powe
board

Rsh
Is

Figure 13 The part of Current feedback on the EVAL-M1-101T evaluation board

Based on the principle of Kirchhoff's voltage law,

R7

R, 6
Vo=V~ Vpp—1 R —+1 Ry, =——Vpp+———R
2 1~ (Vpp sh * sh)*R6+R7 sh * Ksp Re + R, DD Re + R, sh * Isnh
c ¢ input = —5__p _3g
urrent inpu =R+ R, Ron = gRen

Based on this calculation, the current input for the MADK combination of EVAL-M1-101T and EVAL-M1-CM610N3
is 83.3 mV/A, and for the combination of EVAL-M1-101T and EVAL-M1-05-65D it is 208.3 mV/A. Please use same
procedure to calculate the current input for other combinations of MADK boards and enter it into MCEWizard.

Question 68 ; Moo 1 Current Fasdback and Samgps Tuming - Motor 1 Currert Input

P Smues Sy TRfrTEr v
tHc fump Te  Help

Motor 1 Current Fesdback and Sample Timing
Question 68 - Motor 1 Current Input Expand Pcture

This value s product of shunt resistance in mfl ochms and gan
of mternyl cuTent sense amplfer

| -u:%3 jtiur.l}
E =@

,_‘_4?41‘5{3
ol || |

R "L‘::" Cunvont lnput
- f
[(mQ) Gom =N
Ansarer 833 mv/A
Provous Nt

Figure 14 Current feedback configuration in MCEWizard for EVAL-M1-101T and EVAL-M1-CM610N3
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5.1.3 Internal Current feedback amplifier gain configuration

The iMOTION™ controller on this board has the internal current feedback programmable gain amplifier which
has four gain settings: 1x, 3x, 6x and 12x.

The internal Current feedback amplifier gain can be configured in MCEWizard as shown in Figure 15.

| Q) Wfinecn Technologies - MCEWizad 20020
Question 70 : Motor 1 Currert Feedback and Sacrple Timing - Intarnal Current Feedack Armpitfier Gan -

Motor 1 Current Feedback and Sample Timing
Question 70 - Internal Current Feedback Ampiifier Gain Expand Pictute

This is the gan of the current feedback programmabtie gain
amphfiec,

(infineon

AnEwer E

Pravicus et

e — 3

Figure 15 Internal current feedback amplifier gain configuration
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5.2 EVAL-M1-101T analog inputs and their MCEWizard setup

Besides current sensing inputs, IMC101T-T038 provides number of analog inputs for different system functions.
Figure 16 depicts analog inputs of the IMC101T-T038 except current sensing inputs.

C11 AIN3 38
472 AIN3
AIN4 1
[CLAINS L Ajng
DC Bus Voltage Sensing input DCBSENSE s 2 2_ vbe
+3.3V R1 C8
13.3k, 1% 472
§§7k 1%
External Temperature Sense input VTH | S lA S 7 NTC
||._PARAMS | o Apawm
l s N c1ol [472
VSP Analog Voltage Control input—YS2 2 35 | \sp
C12
l 222

Figure 16 Analog inputs on the EVAL-M1-101T evaluation board

5.2.1 DC bus sensing configuration

The low side resistor R1 for the DC bus sensing resistor divider on the controller board EVAL-M1-101T is 13.3kQ,
and should be configured in MCEWizard as shown in Figure 17. For the high side resistor value, please refer to
the Application Note of the corresponding power board.

| R\ it Teckmelagies - MCEWizard 20014 = ] K

Question 24 : Systern DC Bus - DC Bus Sensing Low Resistor -

System DC Bus

Question 24 - DC Bus Sensing Low Resistor Expand Pcure

Normally & resistor diider is used for DC bus voRage sensing
Flaaze spocky tha low resistor value

S0 that the mtamal voltage staling can be caiculated basad on
attenustion of resistor dhdat

High
z
v Resistor

»l
>
A

O To ADGC |

—_— .
i 1 Low AING |
< Hesistor

Warning: Wyong vaiue may lead to under/over voltage fault at s
wrong vokage levels or under/over voltage faults may not
happen ot ol

v

Arsever 133 KOhras

Frevious hex l‘

Figure 17 DC bus sensing configuration in MCEWizard
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5.2.2 NTC shutdown value calculation and configuration

External NTC Temperature shutdown value can be calculated as shown below and configured in MCEWizard as
shown in Figure 18. For pull-up resistor on evaluation power board and NTC value, please refer to the power
board’s Application Note. The value of pull-up resistor on EVAL-M1-101T is 4.87 kQ (see Figure 16).

_ Rpull—up on Control board * Rpull—up on Power board
Rtotal pull-up — R

pull—up on Control board + Rpull—up on Power board

RNTC@setting temperature

Vshut down = Vbp

RNTC@setting temperature + Rtotal pull-up

For example, for EVAL-M1-CM610N3, the pull-up resistor on the power board is 5.6kQ. So the total pull-up
resistance calculates to be 2.605kQ.

The typical value of Ryrc at 100°C is 5.388kQ) for IPM IKCM10H60GA which is used in EVAL-M1-CM610N3. If the
setting temperature is 100°C, the shutdown value should be 2.22V.

@ e e e 101 == W |

File Jaomplo Melp

Question 53 : Motor 1 Fault Conditions - NTC Temperature Shutdown Viskue -

Motor 1 Fault Conditions
Question 53 - NTC Temperature Shutdown Value Expand Pictisre

Sat voitage value for NTC Temperature Shutdown If Over
Tempernture Shutdown s enabled, ‘

If Over Tomparature Shutdown is anabied and voltags at AIN
pn for NTC 15 below this value, motor will stop and enter fauk .

(infineon

ANSuer 22 Vv
VFv:vapus Next
Figure 18 External temperature sense input configuration in MCEWizard
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5.2.3 VSP analog input control mode and PGout configuration

VSP analog input control mode can be configured in the options page for MCEWizard by clicking and selecting
in the pull down list marked with red box as shown in Figure 19.

) otneon Tecrnoboges - MCEWEIT 20020 mieaigm i

| File Jumplo  Help

Options Fage -
Base Configuration Options
Currant Configurabion Symem Freguences
71 1 want to modfy PAM frequancy
Product Family IMOTIONZ MCE o
Mator 1 PWM Frequency 20 KHz
Product Name; IMOTION2
Motors St Configuration: Leg Shung st Contool Rate !
MCE Clock Fraq: 96 M SUAEA s
Motor | PWM Freq 0.0 Iz

Warning: Too high PAM Frequency or wrong control input
ey lead 1o no response at all to external commands,
Custom Cirout Soard: Enabled

Custom MCE Applcation: Desablad

Additional Dptons

Firmmware Verson| ¢ { CPY Ussge/Loading
Motor 1 Shunt Confuguration: teg Shunt « Toral MCE usoge: [ 73% usage
Warning: Makn sure shunt canfiguration matches with Werning: Total MCE Usage should be limited to 90% to allow
hardware CPU svailabdity for cther tasks

Previous Yeest

Figure 19 AnalogVSP control input mode configuration

There are three input thresholds (percentage of controller supply voltage VDD) used to define the relationship
between VSP input voltage and TargetSpeed.

1. T1 (Input threshold for motor start): if the VSP analog voltage is above this threshold, motor will start
2. T2 (Input threshold for motor stop): if the VSP analog voltage is below this threshold, motor will stop

3. T3 (Input threshold for Max RPM): if the VSP analog voltage is higher or equal to this threshold, TargetSpeed
will be 16384 which is Max RPM.

TargetSpeed

16384
(Max RPM)

Maximum Vsp = 3.3V or §V

MinSpd

Vsp

T2 ™ T3
(Motor Stop)  (Motor Start) (MaxRPM)

Figure 20 The relationship between VSP Analog Input voltage and TargetSpeed
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After configured the Analog VSP control input mode, the three input thresholds can be set up in the input text
box in MCEWizard marked with red box as shown in Figure 21, or in the pages for Question 9, Question10 and
Question 11.

| @) tnbrrecn Techmelogies - MCEWizasd 20,020
Advarced Mode -

Syem Moter 1
Systerm Comemunication
1 - Node AN Ras 1
27 UART B Rivte 57600 ~ bpw
Systerm Opbons
3 - Controller Supply Vokage 33 =V
4 - Paremeter Set Number
3§« Mutiple Motor Support MotoriD-Omabled =
7 - Parameter Labsl Motor)

8 - Defauk Parameter Set

9 - Vep voitoge - Motar Stop - T2 33 o
l:n - Yo voktage - Maotor Start - T1 by

11 - Y=o volage - Mator Max 85M - T3 90 b

18 - Auto Restert After Fawlt Enadle * |

| Systern DC Bus

19 - Maamuem DC Bus Vakage s v
W O Base Mhrant b | sysnd 168 )
Frevow
he— —

Figure 21 Three input thresholds configuration for VSP analog input control mode

For Analog VSP control input mode, the motor speed can be calculated by measuring the frequency of PGOUT
signal output of control ICIMC101T-T038. And the pulse generation number per revolution for motor can be
configured in MCEWizard as shown in Figure 22.

| ) Efimecn Technologees - MCEWizard 20.0.20
l Quistan 38 - Matir | Appiaton Infermation - PG Pulse Per Revdlton - |

Maotor 1 Application Information

Question 36 - PG Pulse Par Revolution Expand Pcture
Input PG output PPRL

Mimimusn PPR vedue i 0,013023 " MotorPoles,

Y 1 resolution o

Meaoorvum PP wakee ie bmited of (F_PWM* 301\ Maxitrem "~ -

motor ki) ' I
Putting O for S quéstion wib disabls FG oLt \/\/\\/\\/\/

I
|

i 12PPR “l
Arqwer. 12 FFR
Provous Han
L ol
Figure22 PG Pulse Per Revolution configuration
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Motor speed can be calculated as shown below.

PGOUT Freuqgency(Hz) = 60s
Pulse Per Revolution

Motor speed(RPM) =

For example, PGOUT frequency is about 80 Hz and Pulse per Revolution is 6, and then the motor speed will be
800 RPM.

By default, VDD is 3.3V for EVAL-M1-101T. The input of VSP and PGOUT (pulse generation output) should be
limited within the voltage range of 0 and 3.3V. While for some application, PGOUT should be connected to
speed measurement circuit. The evaluation board EVAL-M1-101T provides FG (Frequency Generation) signal
with an open drain structure controlled by PGOUT as shown in Figure 23. And FG signal can be pull up to 30V.

The frequency of FG is the same as PGOUT, and the calculation equation for motor speed is the same.

FG
1 +3.3V Ral
- | 100R
3 FG
4 GND PGOUT |: Ql
| | — IRLML2030
= N
GND :;
Figure 23 VSP Input Connector and level shit schematic for FG
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5.3 Schematics overview

Figure 24 shows the schematic of EVAL-M1-101T evaluation board with IMC101T-T038 controller.
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Figure 24 The schematics for the EVAL-M1-101T evaluation board

Figure 25 shows the signal test pin connector schematic for EVAL-M1-101T.
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Figure 25 Signal test pin connector schematics for the EVAL-M1-101T evaluation board
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5.4 PCB layout overview

The layout of this board can be used for different voltage or power classes of power board. The PCB has two
electrical layers with 35um copper by default and its size is 65 mm x 45 mm. The PCB board thickness is 1.6mm.
Check the Infineon’s website or get in contact with Infineon’s technical support team to get more detailed
information and the latest Gerber-files.

Figure 26 illustrates the top assembly print and top paste layers of the evaluation board.
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Figure 26 Top overlay print of the EVAL-M1-101T evaluation board

Figure 27 depicts the bottom assembly print of the evaluation board.
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Figure 27 Bottom overlay print of the EVAL-M1-101T evaluation board
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The top layer routing of the PCB is provided in the following Figure 28.

»

Figure 28 Top layer routing of the EVAL-M1-101T

Figure 29 illustrates the bottom layer routing of the PCB.
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Figure 29 Bottom layer routing of the EVAL-M1-101T
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Bill of material

Table 10 provides the complete bill of materials for the EVAL-M1-101T board.

Table 10 Bill of materials
No. | Qty. | Part description Designator | Part Number Manufacturer
1 4 CAP CER 10uF 10V X5R 0603 C1,C105, CCO603KRX5R6BB10 | Yageo
C114,C115 |6
2 5 CAP CERO0.1uF 10V X7R 0603 C2,C3,C4, |885012206020 Wurth Electronics Inc.
C5,C6
3 5 CAP CER 4700pF 10V X7R 0603 C7,Cs, 885012206012 Wurth Electronics Inc.
C10,C11,
C21
1 CAP CER 10000pF 10V X7R 0603 Cc9 885012206014 Wurth Electronics Inc.
3 CAP CER 2200pF 10V X7R 0603 C12,C13, 885012206010 Wurth Electronics Inc.
Cle
6 3 no ass./CAP CER0.1uF 10V X7R Cl14, C17, 885012206020 Wurth Electronics Inc.
0603 C19
7 3 CAP CER 220pF 10V X7R 0603 C15, C18, 885012206004 Wurth Electronics Inc.
C20
8 7 CAP CER 0.1pF 10V X7R 0603 C101, 885012206020 Wurth Electronics Inc.
C102,
C103,
C104,
C108,
C110,C111
9 2 CAP CER 15pF 10V COG/NP0 0603 C106,C107 | 885012006003 Wurth Electronics Inc.
10 2 CAP CER 1pF 10V X7R 0603 C109,C113 | 885012206026 Wurth Electronics Inc.
11 |1 CAP CER 4.7uF 10V X5R 0603 Cl12 885012106012 Wurth Electronics Inc.
12 1 CONN HEADER VERT DUAL 8POS J1 61300821121 Wurth Electronics Inc.
2.54
13 1 CONN HEADER DUAL 20 POS RA J2 61302021021 Wurth Electronics Inc.
2.54
14 1 CONN HEADER VERT DUAL 12POS | JP1 61301221121 Wurth Electronics Inc.
2.54
15 1 CONN HEADER 4 POS 2.54 JP2 61300411121 Wurth Electronics Inc.
16 1 CONN HEADER 5 POS 2.54 JP3 61300511121 Wurth Electronics Inc.
17 1 FERRITE BEAD 60Q 0603 1LN L101 BLM18PG600 Murata Electronics
North America
18 LED RED CLEAR 0603 SMD LED1 150060RS75000 Wurth Electronics Inc.
19 2 LED BLUE CLEAR 0603 SMD LED102 150060BS75000 Wurth Electronics Inc.
20 1 LED GREEN CLEAR 0603 SMD LED2, 150060GS75000 Wurth Electronics Inc.
LED101
21 1 MOSFET N-CH 30V 2.7A SOT-23-3 Q1 IRLML2030 Infineon Technologies
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No. | Qty. | Part description Designator | Part Number Manufacturer
22 1 0SC 12.0000MHz SMD Q101 12MHz/S/3.2X2.5 Quarz
23 |1 RES SMD 13.3kQ 1% 1/10W 0603 R1 RCO603FR-0713K3L | Yageo
24 1 RES SMD 4.87kQ 1% 1/10W 0603 R2 RCO603FR-074K87L | Yageo
25 |5 RES SMD 2kQ 5% 1/10W 0603 R3, R18, RC0603JR-072KL Yageo
R19, R20,
R102
26 2 RES SMD 9.1kQ 5% 1/10W 0603 R4, R101 RC0603JR-079K1L Yageo
27 |1 RES SMD 47Q 5% 1/10W 0603 R5 RC0603JR-0747RL Yageo
28 3 RES SMD 10kQ 1% 1/10W 0603 R6,R9, R12 | RCO603FR-0710KL Yageo
29 3 RES SMD 2kQ 1% 1/10W 0603 R7, R10, RCO603FR-072KL Yageo
R13
30 |4 RES SMD 100Q 5% 1/10W 0603 R8, R11, RC0603JR-07100RL | Yageo
R14, R21
31 5 RES SMD 0Q JUMPER 1/10W 0603 R15, R16, RCO603FR-070RL Yageo
R17,R110,
R111
32 2 RES SMD 10kQ 5% 1/10W 0603 R103, R108 | RC0603JR-0710KL Yageo
33 2 RES SMD 33Q 5% 1/10W 0603 R104, R106 | RC0603JR-0733RL Yageo
34 1 RES SMD 510Q 5% 1/10W 0603 R105 RC0603JR-07510RL | Yageo
35 |1 RES SMD 4.7kQ 5% 1/10W 0603 R107 RC0603JR-074KT7L Yageo
36 |1 RES SMD 1MQ 5% 1/10W 0603 R109 RC0603JR-071ML Yageo
37 10 TEST POINT PC MINI .040"D TP1/+3.3V, |5001 Keystone Electronics
BLACK TP2/UH,
TP3/UL,
TP4/VH,
TP5/VL,
TP6/WH,
TP7/WL,
TP8/GND,
TP9/GK,
TP10/GND
38 1 IC MCU 32BIT 128KB FLASH Ul IMC101T-TO38 Infineon Technologies
38TSSOP
39 1 IC MCU 32BIT 256KB FLASH U101 XMC4200-Q48F256 Infineon Technologies
48VQFN BA
40 1 IC REG LINEAR 3.3V 1A SOT223-4 U102 IFX1117-ME V33 Infineon Technologies
41 1 DGTL ISO 3.75KV GEN PURP 8SOIC | U103 SI8621EC-B-IS Silicon Labs
42 |2 TVS DIODE 17VC WLL-2-1 V101,V102 | ESD237-B1-W0201 Infineon Technologies
43 1 DIODE SCHOTTKY 30V 1A SOD323- | V103 BAS3010A-03W Infineon Technologies
2
44 1 CONN RCPT MICRO USB AB SMD X101 ZX62-AB-5PA Hirose Electric Co Ltd
R/A
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Reference

7 Reference

[1] iMOTION™IMC100 Series Datasheet

[2] iMOTION™IMC100 Software Reference Manual
[3] MCEWizard User Guide

[4] MCEDesigner User Guide

Note: All listed reference materials are available for download on Infineon’s website
www.infineon.com/imotion. All the iMOTION™ MADK power board’s Application Notes are
available at www.infineon.com/MADK
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Revision history

Document Date of release Description of changes
version
1.0 2018-01-31 First release
1.1 2018-01-31 Moved to latest template plus small modifications
1.2 2018-02-09 plus small modifications
1.3 2018-03-02 plus small modifications
1.4 2018-03-29 plus small modifications
1.6 2018-11-27 Modified MCEDesigner setup description in section 4.2.2.
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IMPORTANT NOTICE

The information contained in this application note is
given as a hint for the implementation of the product
only and shall in no event be regarded as a
description or warranty of a certain functionality,
condition or quality of the product. Before
implementation of the product, the recipient of this
application note must verify any function and other
technical information given herein in the real
application. Infineon Technologies hereby disclaims
any and all warranties and liabilities of any kind
(including without limitation warranties of non-
infringement of intellectual property rights of any
third party) with respect to any and all information
given in this application note.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer’s technical departments
to evaluate the suitability of the product for the
intended application and the completeness of the
product information given in this document with
respect to such application.

For further information on the product, technology
delivery terms and conditions and prices please
contact your nearest Infineon Technologies office
(www.infineon.com).

WARNINGS

Due to technical requirements products may contair
dangerous substances. For information on the types
in question please contact your nearest Infineor
Technologies office.

Except as otherwise explicitly approved by Infineor
Technologies in a written document signed by
authorized representatives of Infineor
Technologies, Infineon Technologies’ products may
not be used in any applications where a failure of the
product or any consequences of the use thereof car
reasonably be expected to result in personal injury.
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OCEAN CHIPS

OxreaH INeKTPOHMUKM
MocTaBKa 3ﬂeKTp0HHbIX KOMMOHEHTOB

Komnanusa «OkeaH DNEKTPOHMKM> MpEeAaraeT 3aK/Il04EHUE JONTOCPOYHbIX OTHOLLIEHMM NpU
MOCTaBKaX MMMOPTHbIX 3/1EKTPOHHbIX KOMMOHEHTOB HA B3aMMOBbIrOZHbIX YC10BMAX!

Hawwu npeumyliectsa:

- NlocTaBKa OpMrMHaIbHbIX UMMNOPTHbBIX 3/IEKTPOHHbIX KOMMOHEHTOB HanNpAMYy C NPOM3BOACTB AMEPUKM,
EBponbl M A3uK, a TaK e C KpYNHEMLIMX CKIaJ0B MMPa;

- LUnMpoKas sMHeMKa NOCTaBOK aKTUBHBIX M MACCMBHBIX MMMOPTHbBIX 3/1EKTPOHHbIX KOMMOHEHTOB (6onee
30 MJIH. HAMMEHOBAHUMN);

- MocTaBKa C/IOXKHbIX, AeDUUMUTHBIX, IM60 CHATLIX C NPOM3BOACTBA NO3ULMIA;

- OnepaTMBHbIE CPOKM NOCTABKM NOA 3aKa3 (0T 5 paboumx AHEN);

- JKCnpecc JoCTaBKa B 06YH0 TOYKY Poccuu;

- Momouwb KoHcTpyKTOpCKOro OTAena 1 KOHCynbTauumu KBaMPULUUPOBAHHBIX MHXEHEPOB;

- TexHM4ecKaa nogaepkka NpoeKTa, NomMollb B NoA6ope aHanoros, NocTaBka NPOTOTUNOB;

- [locTaBKa 3/1EKTPOHHbIX KOMMOHEHTOB NoJ, KOHTposiem BIT;

- CUcTeMa MeHeaXXMeHTa KayecTBa cepTudmumpoBaHa no MexayHapogHomy ctaHgapTy 1SO 9001;

- Mp1 HEO06XOAMMOCTH BCA NPOAYKLUMA BOEHHOIO M adPOKOCMMYECKOrO Ha3HaYeHMA NPOXoAUT

MCMbITaHMA M CEPTUMhMKALMIO B TaGOPATOPMM (MO COrIACOBAHMIO C 3aKa34YMKOM);
- MocTaBKa cneumanusmMpoBaHHbIX KOMMOHEHTOB BOEHHOMO M a3POKOCMMYECKOr0 YPOBHSA KayecTBa

(Xilinx, Altera, Analog Devices, Intersil, Interpoint, Microsemi, Actel, Aeroflex, Peregrine, VPT, Syfer,
Eurofarad, Texas Instruments, MS Kennedy, Miteq, Cobham, E2V, MA-COM, Hittite, Mini-Circuits,
General Dynamics u gp.);

KomnaHua «OkeaH JNEeKTPOHMKKU» ABNAETCA oduuMabHbIM AUCTPUOLIOTOPOM M SKCKJIHO3MBHbBIM
npesctasuteneM B Poccum ofHOrO M3  KpPYMHEMWMX MPOM3BOAMUTENIEM Pa3beEMOB BOEHHOMO W
A3pPOKOCMMYECKOro Ha3sHavyeHuMs <«JONHON», a Tak Xe oduuMaibHbiIM AUCTPUOBIOTOPOM MU
JKCK/II03MBHbIM nNpeacTaBuTenieM B Poccvn npousBoauTENA BbICOKOTEXHOIOMMYHBIX M HaAEXHbIX
peweHun ans nepeaaym CBY curHano «FORSTAR>.

«JONHON> (ocHoBsaH B 1970 T.)

PasbeMbl crneumanbHOro, BOEHHOMo M A3POKOCMHNYECKOIo
Ha3Ha4YeHHA:

JONHON (MpuMeHsOTCA B BOEHHOM, aBMALMOHHOM, a3POKOCMMYECKOM,

MOPCKOM, KeNe3HOAOPOXKHOM, TOpHO- M HedTeao6biBatoLLeN
0Tpac/AX NPOMbILLIEHHOCTH)

«FORSTAR> (ocHoBaH B 1998 r.)

BY coegmHmnTENN, KOAKCHaNbHbIE Kabenn

’ ) ®
KabenbHble COOPKM M MMKPOBONIHOBbIE KOMMOHEHTbI: FORS 'AR
L

(MpuMeHsaTCA B TEJIEKOMMYHMKAUMAX  FPaXXAaHCKOro M
cneuManbHOrO HasHayeHus, B cpeacTBax cBA3sM, PJIC, a TaK xe
BOEHHOM,  aBMALUMOHHOM M AdPOKOCMMYECKOM  OTpacisx
NPOMBILLNIEHHOCTH).

TenedoH: 8 (812) 309-75-97 (MHOroKaHasbHbIN)

dakc: 8 (812) 320-03-32

DNIeKTpPOHHas noyTa: ocean@oceanchips.ru

Web: http://oceanchips.ru/

Appec: 198099, r. CaHkT-leTepbypr, yn. KananHuHa, 4. 2, Kopn. 4, amT. A




